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Applying Dim 
 

Many PowerPoint presentations begin by showing all bulleted points. What does the observer 

focus on - all of the bulleted points. An advanced skill is to bring one bullet in at a time. When 

time to move to the next item, dim the previous point.  

 

Here are the directions for applying dim features to bulleted items.  

 

Start a new presentation. On slide two, add at least three items similar to the sample shown 

below. 

 

1. Click on the Advanced Ribbon. 

2. Select Custom Animation. This opens the animation pane. 

 

 
 

 

 

3. Click Add Effect in the Animation Pane. 

4. Select Entrance 

5. Select the way you want the text to enter.  
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6. The text needs to enter when the slide begins. Click on 

the down arrow next to “On Click” then select With 

Previous. 

 

 

 

 

 

 

 

 

7. Right-click on the animation in the animation pane. 

 

 

 

 

 

 

 

 

 

 

8. Select Effect Options.  
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9. Click the Don’t Dim down arrow and choose a 

color you want to show when you advance to the 

next bullet. The color should dim the text, not make 

it disappear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Repeat these steps with the other two items in your list. However, use “On Click” for 

Starting each slide.  

  

 
 

 

Notice the numbers on the left of the bullets, 0, 1, and 2. The first bullet has a 0 because I 

selected this action to begin when the slide was displayed. Number 1 will be displayed when you 

press the mouse and the same for number 2.  

 

| Top | 
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Adding Sound to a PowerPoint Presentation  
 

 
 

1. Click on the Insert Tab 

2. Select Sound from the Insert Ribbon.  

3. Navigate to the sound file you want inserted.  

4. Select the sound file you want to hear.  

5. When returning to the presentation you will see a new window from which you choose to 

play the sound automatically or when clicked.  

 

 

 

 

 

 

 

 

 

 

Select Automatically if you want the sound to play when the slide is opened. Select When 

Clicked if you want the sound to play when you click on the speaker.  Unless you have 

linked the sound file to text or an image, you will see a small speaker on the slide. To 

play the sound, click on the speaker. If playing the sound automatically, it is a good 

idea to hide the speaker or, at least, move it to an inconspicuous part of the slide.  

 

6. To hide the speaker during the slide show, right-click on the 

action, select Effect Options.  
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7. From the new window select 

Sound Settings and check the 

box for Hide sound icon during 

the slide show 
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Adding Video to a PowerPoint Presentation  
 

Adding video to a PowerPoint Presentation is similar to adding sound files.  Videos can be 

played in a small window or a full slide. You can choose the location and size. you can move the 

video placeholder on the slide and resize it.   

 

 
 

1. Click on the Insert Tab 

2. Select Movie from the Insert Ribbon 

3. Select whether to play the video automatically or when clicked. For classroom 

presentations you’d probably want when clicked so you have time to introduce the movie 

and prepare the students to look for certain points. If you choose to play the video 

automatically, it would be best to use a new slide.  

 

 

 

 

 

 

 

4. Resize the video placeholder for your needs.  
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Hyperlinks 
 
Being able to move freely within a presentation is what makes the presentation more 

instructional and interactive. Hyperlinks allow the user to click on an active button and jump 

immediately to a new slide, open a new document, or go to the world wide web. 

 
Linking to another slide 
 

1. Highlight text or an image you want to be the anchor for the hyperlink. In the example 

below, I used text.  

2. Select the Hyperlink from the Insert Tab.  
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3. Select Place in This Document. 4 

4. Pick the slide you want to hyperlink to. OK 

 

 

Hyperlinks – Linking to another document  
 

1. Highlight text or an image you want to be the anchor for the hyperlink. 

2. Select the Hyperlink Tab on the Insert Ribbon.  

3. This time select Existing File of Web Page. Navigate to the document you want to open 

when the linked.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE – If you move the file or PowerPoint presentation to a different computer, 

the file must be moved too.  
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Hyperlinks – Linking to the World Wide Web 

 
1. Highlight text or an image you want to be the anchor for the hyperlink.  

2. Select the Hyperlink Tab on the Insert Ribbon. This time select Existing File of Web 

Page.  

3. In the Address bar type the URL for the website you want to link to.  
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Navigation Control and Action Buttons  
 

If you are using hyperlinks in your presentation, it is a good idea to turn off Advance On Mouse 

Click.  This is especially true if using an interactive presentation. The last thing you want to 

happen is for the user to end up somewhere than the intended location. This is especially, 

especially true if using navigational control and action buttons.  
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Action Buttons 
 

Action Buttons, like those shown on 

the right, will automatically add a 

hyperlink. All you need to do is pick 

the link location.   

 

 

 

 

 

 

 

1. Select Insert and choose Shapes. At the bottom 

of the list is Action buttons. Select one.  

2. After selecting the action button, the cursor 

turns to a + sign. Click the mouse then draw 

your action button.  

3. After the button is drawn, a new window opens. 

From this window, select the action for the 

action button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click the down arrow under Hyperlink to: for a list of actions. 
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Transitions 
 

The way a slide advances to the next slide is called a transition. Fancy transitions can capture an 

audience’s attention. The drawback to using fancy transitions is the audience wont’ be paying 

attention to what you say because they are waiting for the next slide.   

 

PowerPoint has several interesting transition; PowerPoint 2010 has even more. The best way to 

learn what each transition does is to play with all of them. Pick the one you like  

 

1. On the Animations Ribbon, click the dropdown arrow to open the transitions window. 

 

 

 

 

 

 

 

 

 

 

2. Click on a transition to select it.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. If you want a sound to be played during the transition, click the Sound down-arrow.  



Advanced PowerPoint Skills 
Don Carlin 

2012 

14 
4. Click on the sound to select it.  

5. If you have a recording you want to use, select Other Sound. Navigate to your sound file 

and upload it.  

 

 

 

6. You can apply this to one slide or all slides.  Apply to all slides by clicking the Apply to 

All button.  

 

 

 

 

 

 

 

 

 

Caution: Transitions and sounds are “cute”, but can get annoying. I suggest 

not using them.  
 

 

| Top | 
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Appear and Disappear 
 

Appear and Disappear is an interesting feature for presentation. They are good for revealing 

information when you want it and hiding it when you don’t.  

 

 

1. Insert an Image –size it to fit in one 

corner of the slide 

2. Insert two text boxes – one will say 

“Appear” the other will say 

“Disappear” 

 

Your slide should similar to this 

example 

3. Click on the Animations ribbon; 

select Custom Animations 

4. Select the image 

5. From the Custom Animation pane, 

select Add Effect, Entrance, and then Appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Right click on the animation to view animation options. 
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7. Select Timing 

8. Set the trigger options as shown here.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Select the image.  

10. From the Custom Animation pane, select 

Add Effect, Exit, and then select 

Disappear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Set the Trigger as shown here.  
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Multiple Images on One Slide 
 

Having one image appear over another or having an image fade out while another image is 

fading in is an interesting effect. This effect can be applied to text objects too.  

 

1. In a new slide, insert an image.  

2. Open the Animation Ribbon to Custom Animation. 

3. Select the image. 

4. Add an entrance effect.  

5. Add an exit effect to the same image. 

6. Add another image. 

7. Add an entrance effect. 

8. Add an exit effect. 

9. By changing timing it is possible to run through an 

entire show without advancing effects or slides. 

10. In the example on the right, the first image enters, and 

then exits on the mouse click. The second image enters 

as the first image leaves. The third image appears on the 

mouse click; image two exits as the third image appears. 

 

Each image could be set to display for X seconds then the 

next effect would happen. This would make your slide show 

run automatically.  
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Changing Background of an Image to Transparent 
 
Notice how the clipart of the pens comes 

in with a dark background that distracts 

from the subject of the image, the pens. 

We can change that.  

 

 

1. Insert an image into your 

PowerPoint slide. Select the 

image than click the Format Tab.   

2. Select Recolor from the Adjust 

Menu.  

3. Slide down to Set Transparent 

Color. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2 

3 
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4. Some cropping may be 

necessary to remove borders, 

but the image background 

blends with the slide 

background color. 

 

Unfortunately, only one background 

change per image.  
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Photo Albums 
 

 Prior to creating the slideshow, gather all your images in one folder.  

 

PowerPoint can create picture slide shows in a matter of seconds.  

 

1. To do this, select Photo Album from the Insert Ribbon.  

2. Next, select New Photo Album. 

 

 

 

 
 

 

In the new window you will be asked you will select the location of your images write a caption, 

and setup your slide show.  I don’t advise adding captions because PowerPoint creates a slide for 

the image and a slide for the caption. Use a textbox if you really want to label the images.  

 

3. Click on File/Disk to navigate to your image folder.  
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4. To add a caption to a photo, add a textbox on the slide. Don’t use their caption option. 

5. Select Fit to slide for best appearance.  

 

 
 

6. Click Create when finished. 

 

7. Change the title of your slideshow 

if necessary and the slide design.  
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Making your Photo Album Run Automatically 
 

 

 

 
 

1. Select the Animation Ribbon as shown above. 

2. Turn off the On Mouse Click 

3. Select Automatically After and set desired time each slide should show, 3-4 seconds. 

4. Select Apply To All 

 

5. To make the slideshow run continuously, select Set Up Slide Show from the Slide Show 

Ribbon. 
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1. In the new window 

select Presented by a speaker. 

 

2. Select Loop 

continuously until “ESC”.  

 

3. Select Using timings, if 

present.  

 

4. Click OK.  
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Advanced PowerPoint Skills Presentation Rubric 

Skill 3 2 1 0 

Applying Dim 

Three items were 

included in the list and 

each dimed separately 

on mouse click 

Three items were 

include in the list, 

but all dimed at 

once. 

Three items were 

included, but dim 

was not applied. 

Less than three 

items in the list. 

Hyperlinks 

Hyperlinks were 

correctly applied for a 

place in presentation, 

to the WWW, and to a 

document. 

Three hyperlinks 

were used, but one 

did not work 

correctly. 

Three hyperlinks 

were used, but two 

did not work 

correctly. 

Less than three 

hyperlinks were 

used. 

Action Buttons 

Home, next, and 

previous action 

buttons were used and 

all worked correctly. 

Home, next, and 

previous action 

buttons were used, 

but one did not work 

correctly.  

Home, next, and 

previous action 

buttons were used, 

but two did not 

work correctly. 

Less than three 

action buttons were 

used.  

Transitions with 

and without 

Sound 

Transitions with sound 

and without sound 

were demonstrated 

  
No transitions were 

demonstrated 

Appear and 

Disappear 

Appear and Disappear 

was demonstrated 

correctly. 

Appear and 

Disappear was 

demonstrated, but 

one button didn’t 

work correctly 

Appear and 

Disappear was 

demonstrated, but 

neither button  work 

correctly 

Appear and 

Disappear was not 

demonstrated 

Multiple Images  

At least three images 

appear one at a time 

then disappeared prior 

to the next image.  

Three images 

appeared, but didn’t 

disappear prior to 

the next image.  

Less than three 

images were used, 

but appeared and 

disappeared 

correctly.  

No attempt was 

made.  

Transparent 

Background 

A before and after 

image was presented 

showing the 

background color was 

transparent 

An image was 

presented without a 

before image. 

An image was 

presented, but 

transparent wasn’t 

applied.  

No attempt was 

made.  

Slideshow 

A separate slideshow 

with a title slide, five 

slides, and set to run 

automatically was 

demonstrated. 

A separate 

slideshow with a 

title slide, five 

slides, but didn’t run 

automatically was 

submitted. 

An attached 

slideshow with a 

title slide, five slides 

and was set to run 

automatically was 

submitted 

No attempt was 

made.  

Total     

   Project 
Total 

 

 


